Adobe Photoshop CC 2018

By Martin Evening

Welcome to the latest Adobe Photoshop CC bulletin update. This is provided free to ensure everyone can be kept up-to-date with the latest changes that have taken place in Photoshop.

This bulletin coincides with the announcement of Photoshop CC 2018 and content includes basic information about some of the latest features that are new in Photoshop CC 2018. The features described here will be accessible to all Creative Cloud subscribers and those who have purchased the current version of Photoshop CC. For a complete description of how to use these new Photoshop tools, with diagrams and step-by-step tools, I recommend you buy the Adobe Photoshop CC for Photographers: 2018 Edition book, which will be available later this year.
Range masking

Camera Raw now offers Color and Luminance Range Mask controls. The Range Mask options are at the bottom of the Adjustment Brush, Graduated Filter and Radial Filter panels. For example, if you apply a localized adjustment and select the Color Range Mask option (Figure 1), you can mask an adjustment based on a sampled color. To do this select the Eyedropper tool and use a single click to define the color you wish to mask, such as a blue sky. The Color Range slider can then be used to adjust the depth of the color range selection. Dragging the slider to the left narrows the range. Dragging to the right widens, but you’ll notice how the Color Range Mask selection becomes smoother and more diffuse. Therefore, lower settings are required for more precise masking. The localized adjustment is restricted to the color range selection area and to preview the range mask you can hold down the `alt` key as you drag the Color Range slider to see a temporary black and white mask preview.

To refine a color range selection you can click again to sample a new color, or you can marquee drag to make a broader color range selection. To add more sample points, click or drag again with the `shift` key held down. To exit the Eyedropper mode, click the tool button again, or press the `esc` key.

Alternatively you can use the Luminance Range Mask mode (Figure 2). Using the Luminance Range slider you can drag the shadow and highlight handles to control the range of luminance tones that are selected based on the sampled area. Meanwhile, the Smoothness slider can be used to refine the selection. You can also hold down the `alt` key as you drag the Luminance Range and Smoothness sliders to see a temporary black and white mask preview.

The Color Range and Luminance Range mask controls make Camera Raw masking that much simpler to create and adjust. The smoothness of this masking method is a big improvement upon the Auto mask method whereby the mask edge can sometimes end up being quite blocky and you see edge artifacts. With these new masking controls you can achieve much smoother edge blends. In extreme cases you are still likely to see some edge artifacts, but this can be mitigated by fine-tuning the slider settings.
1 In this step I added a Graduated Filter adjustment that darkened the sky, where the Range Mask was set to None.

2 I selected the Color Range Mask mode and with the Eyedropper tool selected marquee the sky to sample the sky colors. I then held down the Shift key to add further color samples. Finally, I adjusted the Color Range slider to soften the mask slightly.
Lightroom photos in the Start Workspace

The first time you launch Photoshop you will see a Start workspace screen, but this will only appear if the Photoshop program is in Application Frame mode (which it will be by default). Here, you can view a list of documents you have opened most recently in Photoshop. As soon as you open an image via the Start screen or via Bridge, the interface switches to the regular workspace configuration and the Start screen disappears.

The Lr Photos section (Figure 3) lets you access photos imported or synced to Lightroom CC/mobile. This is dependent on you also being subscribed to Lightroom CC of course. If need be, click on the Refresh button to update the LR Photos view.

To open, either double-click on a file or single-click on the photos you wish to download and click Import Selected. If opening a raw image via Camera Raw, you’ll need to click Open Image to open in Photoshop. This is all dependent on full resolution data being available. Where only Smart Previews have been uploaded so far to the cloud this opens a lower resolution version instead. After editing an image you can use the Share feature to add the edited version to Lightroom CC.

Figure 3 The LR Photos option in the Start screen.
Deep Upscale resampling in Image Size dialog

If you check the Enable Preserve Details 2.0 Upscale option in the Technology Previews preferences, the Preserve Details resampling method utilizes an artificial intelligence trained resampling model (known as Deep Upscaling). This uses a deep learning neural network model that detects and preserves the most important details and textures in images when resizing, without introducing over-sharpening of prominent edges or smoothing out lower contrast details. It better preserves localized areas of texture and critical edges that can otherwise appear smoothed out in traditional resampling methods. The downside is that upsizing using this new method does take longer than usual to process.

Figure 4 The Image Size dialog with Preserve Details resample option selected.
Editing spherical panoramas in Photoshop

One major problem editing spherical panorama images in Photoshop is the curved lines. A more intuitive way to do the editing is to put the image into a panoramic view mode and edit the image within that viewer environment. To do this, open a prepared spherical panorama image like the one below and choose 3D ⇒ Spherical Panorama ⇒ New Panorama Layer From Selected Layer. With the Move tool selected, you can click and drag to look around inside the panorama. You can also adjust the Field of View via the Properties Panel. Essentially, this lets you place a virtual camera within the 3D view and choose a desired angle of view.

In the default Texture mode you can work fairly quickly. To match the perspective of the scene, select the Projection Paint System mode. For example, if working with the Clone Stamp tool you will want to select Projection so that the source and target align correctly. Painting can be particularly difficult at the North and South pole. Depending on the resolution of the document and the panorama itself, you may experience artifacts when painting in those areas. To help get around this, create an empty new layer above the panorama layer, select the Brush tool and work on the image. Before you move the camera again, first select Merge Down from the Layers Panel menu or use ⌘ E (Mac), ctrl E (PC).

1 I opened a spherical panorama Photomerge that had been merged and edited in Photoshop to create a 360° wraparound image.
2 In Photoshop I went to the 3D menu and chose Spherical Panorama ➪ New Panorama Layer from Selected layer. I was now able to view and inspect the spherical panorama in a flat perspective.

3 In the Properties panel I adjusted the Field of View (FOV) setting to that of an 8 mm lens camera angle. I was able to use the Move tool to move around the scene, but also use the widgets (circled) to navigate the scene.

4 I selected the Clone Stamp tool to edit the photo and remove the fire extinguisher in the bottom right corner. In the Properties panel I selected Projection from the Paint System menu. This ensured the Clone Stamp editing matched the perspective of the current view.
Sharing images

If you go to the File menu and choose Share, or click on the Share button in the Options bar (circled in Figure 5) this opens the Share dialog shown below. This lets you easily share content you are currently working on. For example, you can select Original size or Small (up to 1200 x 800 pixels) from the Share dialog menu and then click on one of the services listed below to share what you are currently working on with others.

The Share menu lists native sharing systems, including services such as Facebook and Twitter. You can also add photos to Lightroom CC (providing you have a Lightroom CC subscription). The example below shows how you can select the Mail option to email a photo from Photoshop as you are working on an image.

Figure 5 An example of how the Share feature can be used to quickly share what you are working on in Photoshop with others.
Rich tool tips
Whenever you leave a cursor hovering over any one of the Photoshop buttons or tool icons a tool tip box normally appears after a few seconds. This is dependent on having the ‘Show Tool Tips’ option selected in the Tools preferences. If the ‘Use Rich Tool Tips’ option is also checked, this lets new users explore Photoshop. The Rich Tool tips show animated content that helps explain the function of each selected tool (see Figure 6).

Learn panel
The Learn panel (Figure 7) teaches you Photoshop basics without having to leave Photoshop. When opened it can be used to take you through various Photoshop tasks step by step. This includes coach marks that show you where to click next. The Learn panel can also recognize when you have successfully completed a step and automatically open sample files for you to work with.

Figure 6 An example of the new style Rich Tool tips.

Figure 7 The Learn panel.
In-app searches

To carry out a Photoshop search, choose Edit ➔ Search (⌘ F [Mac], 
ctr F [PC]). This keyboard shortcut replaces applying the last used filter. Choosing Edit ➔ Search opens the dialogs shown below, where 
you can type to selectively search Photoshop, the Learning center, 
Adobe Stock, or all three.

In Figure 8 I clicked in the Search field and typed “brush tool”. This 
revealed a number of suggestions for tools inside Photoshop, along 
with associated keyboard shortcuts. Clicking on a listed tool also selects 
that tool and dismisses the Search dialog. Figure 9 shows a search for 
“people” using an Lr Photos search.
Pen path options

The Path Display options (Figure 10) can be used to control the path appearance. With the advent of high resolution displays for Mac and PC, the visibility of pen paths in Photoshop has been a real problem. This has been solved by allowing users to adjust the path width thickness and color. The default setting is 1 pixel. This is perhaps a little too wide for precision work, but you can select other options from the Thickness menu. You can also type in a specific Thickness value as long as this is between 0.5 and 3.0 pixels. The default pen path color is blue, but you can mouse-down on the Color menu to select other path color options.

Curvature Pen tool

The Curvature pen tool is like a simplified version of the regular Pen tool and can help you draw smooth, flowing lines. Normally you need to have some idea of the direction to drag the handles in order to create your intended curve shape. With the Curvature pen tool you simply click and click to create a series of curves. No dragging is required, as Photoshop works this all out for you. To edit a path using the Curvature Pen tool you can push or pull the path segments directly and double-click to switch between adding a curved and a non-curved segment.

Figure 11 shows a sequence of path segments created using the Curvature Pen tool. These segments were created using a series of single clicks. The first two clicks created a straight line segment. However, a third click created a curved segment between the second and third anchor point, but this also changed the first segment to a curved segment. Subsequent clicks added more curved segments, where each new segment also changed the shape of the one before it. With this in mind you can see how the Curvature Pen tool is not always the most appropriate type of tool to use to define a subject outline. The reason being that each anchor point you add affects the shape of the two preceding path segments. In some cases this is a good thing because it helps you to draw smoother shaped curves. But equally, it can be a frustrating experience, as you have less control compared to the regular Pen tool. It is nonetheless a useful tool for creating smooth shape outlines.
The Brushes panel (Figure 12) can be used to select the brush shape you wish to work with. This new, updated panel allows you to create new brush groups and organize brushes into expandable folders. When Show Recent Brushes is checked (highlighted in Figure 12) the most recently used brushes will appear listed at the top of the Brushes panel.

**Saving Brush tool presets**

When you have finished adjusting the Brush Settings panel settings, you can save combinations of the brush preset shape/size, attribute settings, and brush color as new presets. To do this, go to the Brushes panel and click on the Create New Brush button at the bottom (see Figure 13). Give the brush preset a name and click OK to add to the current list. Once you have saved a brush preset, you can access it at any time via the Brushes panel or via the Brush Preset Picker menu in the Options bar. Selecting a Brush preset when any other tool is selected will automatically switch to the Brush tool with that preset active.
Brush stroke smoothing

The Smooth slider control in the Options bar for the Brush, Eraser, Mixer Brush and Pencil tools can be used to vary the amount of brush smoothing. This can help you produce smoother brush strokes when painting (even when using a mouse) and smooth out any jaggedness in your brush drawing.

The Smoothing Options (Figure 14) are accessed via the gear wheel next to the slider. When Stroke Catch-up is checked, the paint stroke will continue to draw up to the cursor while a brush stroke is paused (see Figure 15). Otherwise, the brush stroke will stop when the cursor stops moving. Catch-up on Stroke End continues the brush stroke to the point where you release the mouse click or lift the stylus. This is useful for getting paint strokes to connect up to where you lift the cursor. When this is unchecked the paint drawing discontinues as soon as you release the mouse or lift the pen. When the Pulled String Mode is checked the Stroke Catch-up and Catch-up on Stroke End options are grayed out. This essentially provides some slack to the pen/mouse drawing input and can best be described as ‘towing’ the direction of the pen/mouse drawing. One advantage of this mode is that it enables you to combine smooth curves with sharp corners. The Adjust for Zoom option links the smoothness to the document zoom level. As the zoom level is decreased the smoothing is increased.

Figure 15 An example of painting using 100% brush smoothing with the Show Brush Leash option checked in the Cursor preferences.
Paint Symmetry

Paint symmetry is supported for the Photoshop paint tools (except the Mixer Brush) and is enabled whenever you have the Enable Paint Symmetry option checked in the Technology Previews preferences. To use, select a paint tool such as the Brush tool. From the Options bar (Figure 16) click on the Paint Symmetry icon (circled) to reveal the Symmetry menu options. Here, you can choose one of the guides from the menu list, or select a current, active pen path. You can also use this menu to turn Symmetry on or off.

After selecting a guide this creates a reflecting plane, or two planes in the case of the Dual Axis example shown in Figure 17. As you paint the brush strokes you apply are reflected in the other plane or planes. Note that bristle tip brushes cannot be used when paint symmetry is enabled. Only regular brush tips will work. While most types of brush strokes are reflected as mirror images it is interesting to paint with Scattering enabled in the Brush Settings. This creates a mirror brush stroke, but with a certain randomness, which you can see in the peach colored brush strokes using the Scattered Leaves brush preset.
Better PNG Compression

The new style PNG Save dialog is shown in Figure 18. There is now support for PNG files up to 2 GB in size with new speed improvements when saving big files as PNG.

![PNG Save dialog](image)

**Figure 18** The PNG Save dialog.

Copying and Pasting layers in Photoshop

You can now copy and paste layers in Photoshop, both inside a document and between documents, using the Copy (⌘ C [Mac], ctrl C [PC]), Paste (⌘ V [Mac], ctrl V [PC]) and Paste In Place (⌘ Shift V [Mac], ctrl Shift V [PC]) commands. When you paste a layer between documents with different resolutions, the pasted layer retains its pixel dimensions. Copying a shape layer and pasting will only work so long as the shape path is not also selected. Similarly copying a layer with a vector mask and pasting will only work providing the vector mask path is not also selected. If a shape path or vector mask path are selected, copying copies just the path only to the clipboard.

By Martin Evening


768 pages + Online website
Order via Focal Press secure online ordering: www.routledge.com
For more information go to the book website: www.photoshopforphotographers.com